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How to Utilize WMS Imagery Services. 
 

This document is intended to demonstrate how to utilize the imagery provided by WMS (Web Mapping 
Services). 

 
The Georgia DOT has contracted with a service that provides Aerial imagery and Roadway information 
through these services. 

 
The following verbiage shall be included in all printed publications as part of  

GDOT’s licensing agreement 
 

”Microsoft Bing® used with permission from Microsoft Corporation.” 
 

This note is provided as a cell in the latest version of the GDOT-GN-Sheets.cel library. 
The cell is GBNGLO and should be placed in the file at a legible scale based upon the scale of the plot 

 
 

 

Acquiring the WMS files 
 

Step-1: Open the following location from Windows Explorer: 
\\gdot.ad.local\gdot\Preconstruction\RoadDesign\Imagery\GDOT-WMS-services\BING\ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step-2: Select all of the files shown above and copy them to your current working project 
directory. At this time, a copy of these files will be required in each project folder in which you 

wish to use them. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step-3: Paste these files into your PI# Project folder. (Example: 1801234\1801234CNCP.dgn.) 



 

Utilizing the WMS files 
 

Step-1: Create a new Microstation V8i file (Example: 1801234CNCP.dgn file). 
 

 

Step-2: Then Click here to open the new 1801234CNCP.dgn file 
. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 



 

Preparing the file to Reference the WMS Imagery 
 

Step-1: You will need to determine the Zone location of the project for the Georgia State Plane 
Coordinate 
System. The choices are the GA83-WF for the West Zone and the GA83-EF for the East Zone 

as shown in the map below. Our sample 1801234CNCP.dgn is located in Paulding County 
which is located in the West Zone. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step-2:  When the Correct zone is determined, Use the following GDOT View Menu to select the Coordinate 
system 

 
Define the proper Geocoordinate system using this menu 

  

GA83-EF   for Eastern zone              GA83-WF    for Western zone 

 
This is DGN file specific and only needs to be selected once per DGN file. You will not see any visible 

change on the screen. This is just assigning the coordinate system to the file. 
 
 

There is no harm in re-entering the command. This command does not change any 



 

coordinates but rather identifies the coordinates with the proper Geographic Coordinate 

system. 

 
If you have a previous Geographic Coordinate System attached, you may receive the 

Geographic Coordinate System Changed dialog box. Please select “Correcting the Geographic 

Coordinate System-do not reproject the data” radio button and click OK. 

 

Step-4:  Change the Active level to one of the following RAST levels. 
 

 
 

 

Step-5: Attach the reference files to be displayed. 

In Microstation V8i>File>References>Tools>Attach 
 

Choose the file you wish to attach and make sure to change the Attachment Method to  

Coincident World 
 

 
 

For our example we are choosing the WMS-West-Aerial-2d.dgn file. 

Choose the Fit Reference or Fit All command and select the view with a data button. 

 
 

 

The display will update with a view of the Western half of Georgia. 
Note: It may take a moment for the display to show based upon network speed. 

 



 

 
 

You may also attach additional reference files based upon your needs. 
 
The imagery has different resolution with increasingly better resolution the further you zoom in 

and will refresh itself based on the zoom level as shown in the image(s) below. 

Note: This may take some time due to network speed. 
 

 

 
 



 

 
 
 

And as you increasingly Zoom in the resolution will get better but may take a moment to update 
on the screen (as shown below). 

 
 

  



 

Options for Imagery 
 

 

Currently there are three options provided for this imagery: (Substitute East instead of West for                    

East Zone project). Aerial Imagery (WMS-West-Aerial-2d.dgn) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Aerial Imagery with Labels (WMS-West-Aerial-with-labels-2d.dgn) 

 
 

Roads Only (WMS-West-Road-2d.dgn) 

 



 

Trouble Shooting and additional notes: 
 

 
As this is a new process and procedure, please submit requests for 

enhancements/additions to the Solution Center based upon your needs. 
 

For instructions on Plotting, please refer to the Concepts Section in the GPlot 
Document under the Help (tab) of the GDOT Root Menu in MicroStation V8i. 

 
The reference file display may be turned off based upon your needs. 

 
 

 You may experience the following images displaying a camera in your MicroStation view. 

The imagery only allows viewing down to a particular zoom level and you may have to 

zoom back out for the image to reappear. This also may happen from time to time based 

upon network speed even when zoomed out. 
 

 
 

A MicroStation J DGN files may be attached to a V8 DGN file as a reference and also 

utilizes this imagery as long as: 

A V8 DGN file is used as the base file. 
Define the proper Geocoordinate system using this View menu 

  

GA83-EF   for Eastern zone              GA83-WF    for Western zone 

Make Sure the Reference is attached with Coincident World. 



 

Questions or Comments? 
 

For questions or comments about this document or any other MicroStation related 
issues, please contact the GDOT Solutions Center help desk. 

 
GDOT Solutions Center 
Phone: (404 )631-1220 

Email:  SolutionsCenter@dot.ga.gov 
 

(When submitting issues to the Solutions Center please specify a subject line of “MicroStation” 
So the issue will be assigned correctly.) 

 

Creating “Static” Background images for your project 
 

1. Create new V8 2d dgn file.  

(Name is insignificant at this point; it is just a temporary file for construction purposes).  

2. Open this file in MicroStation V8i SS2.  

3. Assign a coordinate system by selecting one of the following Pre-set Microstation Geographic 

keyins – “geocoordinate assign” from a Library provided in WMS.  

See help on GDOT-Root (WMS imagery in Microstation) 

 

GA83-WF   for Western zone 

GA83-EF    for Eastern zone 

4. Attach reference of area you wish to cover (topo, main, or WMS imagery). Make sure to use 

coincident world when attaching these files. These files may also be Microstation J files as 

demonstrated in this example. 

It is best to rotate the file where a majority of the project area is horizontal on the screen. 

 

5. Attach GDOT-GN-Sheets.cel cell library. Choose one of the following cells: 

GLG50, GLG75, GLG100, GLG125, GLG150, GLG175, GLG200. These cells are representations of 

mailto:SolutionsCenter@dot.ga.gov


 

long plot borders 35 wide by 50, 75, 100, 125, 150, 175 or 200 long.  

Set scale to cover area you are interested in  

It doesn’t have to be an exact scale at this point. If a scale of 178 gets you the area you need 

then that is OK. 

 Smallest number that works will give it the best quality. I would suggest keeping the scale at 

200 or lower. 

 There are different size from 35x50 (GLG50) in increments of 25 up to 35x200 (GLG200). Use 

whichever works best for your circumstance. 

6. Detach any reference files other than the WMS and make sure you don't have anything drawn 

in this area because you are creating a background only. At this point we are just creating the 

background image. 

7. Use the background color plotting from the concept tab that corresponds to the size cell you 

used. This process may take up to an hour or more depending on your network and time of 

day.  

Creating the “Background” – Color Plot 
 
 
 

 
 

• “Background – Color Plot”:  (Used for creating background imagery color plots in which 
services like WMS (web mapping services) are utilized. This is most typically used for 
creating static PDF images for use as backgrounds generated from WMS imagery.  



 

This allows the resulting PDF to be used as the background image and speeds performance 
of generating future plots. 

• Note: While this assists in the creation of future plots, this process can take quite 
some time on initial plots and should be performed in off peak times or after hours. 

 

 
 

Sizes – (Using sheet cells from GDOT-GN-Sheets.cel library) 
 

o 35” x 50” Roll plot using GLG50 cell “35’x50” Sheet Size” 

o 35” x 75” Roll plot using GLG75 cell “35’x75” Sheet Size” 

o 35” x 100” Roll plot using GLG100 cell “35’x100” Sheet Size” 

o 35” x 125” Roll plot using GLG125 cell “35’x125” Sheet Size” 

o 35” x 150” Roll plot using GLG150 cell “35’x150” Sheet Size” 

o 35” x 175” Roll plot using GLG175 cell “35’x175” Sheet Size” 

o 35” x 200” Roll plot using GLG200 cell “35’x200” Sheet Size” 

 

“Background”                                  Naming Conventions 
Example: 
1801234_BGRD.dgn (Background) 
 
Menu Item  Output filename 
 
Background 

 
35”x50” PDF Color BGRD-35x50-1801234_BGRD.PDF 
35”x75” PDF Color BGRD-35x75-1801234_BGRD.PDF 
35”x100” PDF Color BGRD-35x100-1801234_BGRD.PDF 
35”x125” PDF Color BGRD-35x125-1801234_BGRD.PDF 
35”x150” PDF Color BGRD-35x150-1801234_BGRD.PDF 
35”x175” PDF Color BGRD-35x175-1801234_BGRD.PDF 
35”x200” PDF Color BGRD-35x200-1801234_BGRD.PDF 

 
 
 

Note: 

This method forces the user to place a fence around either the: 
Outside (green) border for 24 x 36 or 12 x 18 plots Inside (yellow) border for 
11 x 17 or 8.5 x 11 plots Or Large border for roll plots. 

The system wi l l  prompt  the user to accept the filename or they may enter in their own. 

 

8. When PDF file finishes. 

 



 

9. Create a new V8 2d dgn file 123456BGRD.dgn (background). You may need to make multiple 

files depending on size of the layout-project. Think about how you may want to display them if 

you attend a PIOH or Public Information Open House meeting. 

Example names - 1234567BGRD1.dgn 1234567BGRD2.dgn etc….This naming convention isn’t 

crucial but probably helps for consistency purposes. (BGRD=Background) 

10. Set coordinate system. Make your selection like you did in the DGN file from the GDOT View 

Menus 2 new buttons on the main menu screen. 

 

GA83-WF   for Western zone 

GA83-EF    for Eastern zone 

11. Attach using the Bentley Tool for displaying RASTER Reference Files -- Raster Manager 

Select the PDF you created. Set the level in the New DGN file to a Raster Level from the Bentley 

Level Manager.  (listed below – Pre-Defined) 

File>Raster Manager>File>Attach>Raster ‘keyin PDF file name you just created’. Make sure the 

coordinate system is set to the Georgia East ‘GA83-EF’ or West ‘GA83-WF’ Zone.  

There are 4 pre-defined Microstation levels available. It doesn’t matter which one you select, it is 

important that you must pre-select a level, because plotting is defined with the proper settings 

for displaying the proper output for any of the predefined levels.  

The Pre- Defined Raster Level Names are:  

RAST_Dsgn_LVL1  -  RAST_Dsgn_LVL2 

RAST_Dsgn_LVL3  -  RAST_Dsgn_LVL4 

12. Select the view command - Fit All. The raster should now show up.  

       This New DGN file with the Raster PDF attached CAN NOW be ATTACHED to a NEW DGN file 

as a Regular ‘Reference File’ and contains the PDF file as the background image. The purpose 

is to make the plotting process much faster. By doing this it saves Microstation from having to 

read/process the entire State of Georgia Raster Image. 

Note: This file is only used for the purposes of creating the static background image. 

  



 

Creating the “Concept” – Color Plot 
 
 
 

 
 

• “Concept – Color Plot”:  (Used for generating individual color plots in which background 
imagery is attached. This is most typically used for Concept layouts but can be used for 
other plots that require imagery to show in the background. 

• Note: These plots can take quite some time when using non-static images (such as 
WMS imagery) and should be performed in off peak times or after hours. 

 

 
 

Sizes – (Using sheet cells from GDOT-GN-Sheets.cel library) (GPLN and SRVPLN) 
 

o 24” x 36” Output utilizing outside plot border “Plan Sheet Size” 

o 12” x 18” Output utilizing outside plot border “Plan Sheet Half Size” 

o 11” x 17” Output utilizing  inside plot border “11x17 Sheet Size” 

o 8.5” x 11” Output utilizing  inside plot border “8.5x11 Sheet Size” 

o 35” x 50” Roll plot using GLG50 cell “35’x50” Sheet Size” 

o 35” x 75” Roll plot using GLG75 cell “35’x75” Sheet Size” 

o 35” x 100” Roll plot using GLG100 cell “35’x100” Sheet Size” 

o 35” x 125” Roll plot using GLG125 cell “35’x125” Sheet Size” 

o 35” x 150” Roll plot using GLG150 cell “35’x150” Sheet Size” 

o 35” x 175” Roll plot using GLG175 cell “35’x175” Sheet Size” 

o 35” x 200” Roll plot using GLG200 cell “35’x200” Sheet Size” 



 

“Concept”   Naming Conventions 
 

Example: 
1801234_CNCP.dgn (Concept file) 

 
Menu Item  Output filename 

 
Concept 
24”x36” PDF Color Concept-24x36-1801234_CNCP.PDF 
12”x18” PDF Color Concept-12x18-1801234_CNCP.PDF 
11”x17” PDF Color Concept-11x17-1801234_CNCP.PDF 
8.5”x11” PDF Color Concept-85x11-1801234_CNCP.PDF 

 
35”x50” PDF Color Concept-35x50-1801234_CNCP.PDF 
35”x75” PDF Color Concept-35x75-1801234_CNCP.PDF 
35”x100” PDF Color Concept-35x100-1801234_CNCP.PDF 
35”x125” PDF Color Concept-35x125-1801234_CNCP.PDF 
35”x150” PDF Color Concept-35x150-1801234_CNCP.PDF 
35”x175” PDF Color Concept-35x175-1801234_CNCP.PDF 
35”x200” PDF Color Concept-35x200-1801234_CNCP.PDF 

 
 
 

Note: 
This method forces the user to place a fence around either the: 

Outside (green) border for 24 x 36 or 12 x 18 plots Inside (yellow) border for 
11 x 17 or 8.5 x 11 plots Or Large border for roll plots. 

 
 

The user then will be prompted to accept the filename or they may enter in their own. 


